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A. Overview	

SiteWorx/OS models the existing and proposed surfaces from many file types. These surface models are 
used to calculate quantities of soil movement. 
 
The SiteWorx/OS features available depend on the file type being used. Data from raster files (such as 
TIFF, many PDF files, scanned documents and others) are recorded by clicking the pixels on-screen. 
When using Vector PDF files, data is input into SiteWorx/OS by selecting the entity, such as a contour 
line, with a single mouse click. When working with CAD files such as AutoCAD DWG, all entities and 
elevations contained in a design layer can be quickly imported into the SiteWorx/OS file. In general, 
working with vector PDF and AutoCAD DWG files, are easier, faster and more accurate than working 
with raster files.  
 
This tutorial will demonstrate a takeoff using a multipage PDF vector file. Information about trenches, 
bore logs and importing elevations from a DWG file are also covered in this tutorial.  
 
To understand this software, we highly recommend working through this tutorial step by step. To access 
context sensitive help when working with SiteWorx/OS, click the small blue circle with the question 
mark in the far top right-hand corner of the window and then click the mouse when over a command on 
the toolbar.  If you have any questions or problems whatsoever, please contact us at 800-989-4243, 214-
340-9436 or support@vertigraph.com.  
 
Wishing you the best of everything. Good luck.  
 

B. About	the	SiteWorx/OS	Window	

The SiteWorx/OS window has the following parts: 
 

1. File Menu/Icon 

2. Tabs   

3. Toolbar 

4. Menus section of Toolbar 

5. Help 

6. Tabbed Work Area 

7. Status Bar  
 

1. File Menu/Icon 
To open, save or start a new project, click on the file menu/icon found on the top left hand 
corner of the window.  

 

2. Tabs   
The tabs at the top of the window are named Project, Drawings, Takeoff, Calculations, 3D 
View, Cross Sections, Grid Data and Soil Analysis. Work from left to right along the tabs. 
Start at the Project tab, where the project is defined. At the Drawings tab files are opened and 
the scale is set. The Takeoff tab is where elevations and areas are entered or imported from the 
plan file(s). Much of the work is done at the Takeoff tab. Each tab is covered in this tutorial.  
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3. Toolbar 
The toolbar ribbon contains the program commands. Each tab will have a unique toolbar. Each 
toolbar is divided into sections; the section names are at the bottom of the toolbar.  
 

4. Menu Section of the toolbar 
The right side of the toolbar contains the SiteWorx/OS menus. To learn more about the 
commands on the menus, click the help question mark in the top right hand corner of the 
window, move the question mark pointer over the menu and click.  

 
5. Help 

The question mark in the top right corner of the window provides context sensitive help. Click 
the question mark and then click a menu or command for explanation. The F1 keyboard key 
also provides context sensitive help.  

 
6. Tabbed Work Area 

The work area is the portion of the SiteWorx/OS window between the toolbar at the top and the 
status bar at the bottom. Data is entered and results are analyzed in the work area.  
 

7. Status Bar 
The status bar is at the bottom of the window. The status bar displays the following information 
from left to right:  i) Important instructions and status messages pertaining to the current 
activity ii) Project file name iii) Drawing file name and iv) Notation that identifies how the 
image is rendered – RASTER, PDF, Vector PDF or CAD.  
 

C. 	File	Types	‐	Raster,	Vector	and	PDF	Files	

SiteWorx/OS works with both raster and vector files. Although somewhat technical, it is important to 
understand these file types.  
 

Raster File Images 

 
A raster graphic file displays the grading plan as a rectangular grid of small rectangular cells called 
pixels, or points of color. The image is built up from these tiny pixel cells. The smaller and closer the 
pixel cells, the better the quality of the image (i.e. higher resolution). Raster images are files with the 
following file extensions: some PDF, TIFF, JPEG, CMP, BMP et al. Photos and scanned blueprints are 
examples of raster images. When recording contour lines, points and areas from raster files, individual 
pixel cells are clicked with the mouse to record the item.  

 

Vector File Images 
 
A vector graphic image is different than a raster image. Vector files contain more information than the 
color coded pixels found in a raster file. A vector graphic uses geometric objects such as points, lines, 
curves and polygons that are based on mathematical expressions. A vector graphic contains geometric 
objects at certain locations. These geometric objects are organized in layers in a vector file. Vector files 
are computer aided design (“CAD”) files with the following extensions:  AutoCAD DWG, DWF, DXF 
and some PDF.  
 
When working with vector graphic images with layers, SiteWorx/OS can isolate the design layer and 
hide all irrelevant information. Additionally, the objects in vector graphic images are taken off by 
importing the objects or by snapping to the entity point or selecting the entire entity/object with a single 
click.  Vector files provide increased speed, accuracy and ease of use. Most grading plans are created by 
the designer as a CAD file such as AutoCAD DWG. Often these CAD files are then distributed to the 
contractor as PDF files.  The PDF file distributed can be either a raster type PDF file or, if the PDF file 
was created from the CAD file, a vector type PDF file.  If the vector files such as AutoCAD DWG or 
vector PDF, are available, we recommend that you use the vector type file instead of the raster file.  
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PDF Files 
 
PDF files are listed above as both a raster and vector file format. PDF files contain both pixel and vector 
data and some PDF files are highly complex.  PDF files that contain layers indicate the PDF file was 
created from CAD software such as AutoCAD. PDF files that contain layers are known as “vector PDF 
files”. PDF files that do not contain layers are noted in this tutorial as “raster PDF files” which will 
display the PDF image using pixels. When working with a PDF vector file, SiteWorx/OS allows you to 
isolate the PDF layer and single click on the contour line for quick, accurate and easy takeoff. 
  

How the takeoff is accomplished, and what options are available, are determined by the file type. When 
opening a file with SiteWorx/OS, how the file is rendered or displayed is disclosed on the bottom right 
corner on the status bar. The file will be rendered as one of the following: 

 

 PDF for raster type PDF files 

 Raster for non PDF raster files such as TIFF, JPEG, BMP and others 

 PDF (Vector) for vector type PDF files 

 CAD for DWG, DXF and other Computer Aided Design files which are vector files. 

 If Adobe Acrobat is installed to your computer, you can use Acrobat to read PDF files.  When 
Use Acrobat is turned on at the Options | Setup menu, ACRO will display on the status bar 
whenever any PDF file that is rendered using Adobe Acrobat. 

 
This tutorial demonstrates a complete takeoff using a multipage PDF (Vector) file.  Towards the end of 
the tutorial, importing objects from a DWG CAD vector file are also covered.  
 
Now let’s get started …  
  

D. 	Project	Tab	

Start the takeoff at the Project tab. Here the project is defined. For this tutorial, simply input the 
project name as “Tutorial Project”. The information entered here appears on the reports. This 
project will not use bore logs. 
 
The user defined fields displayed on this Project tab may be changed at the Options menu | 
Setup | User Defined Fields/Reports at any time. Working with boring logs is covered under the 
Boring Logs chapter towards the end of this tutorial.  
 

E. 	Drawings	Tab	

After entering information at the Project tab, the Drawings tab is where files and/or pages are opened. 
After clicking on the Drawings tab the user is asked to save changes to the current project. Answer Yes 
and enter “Tutorial” as the file name and click the Save button. This tutorial walks through a project 
using the installed Top of Curb Multipage.pdf file.  

Step	1	‐	Open	the	drawing	files	
 

   
 
Click the Open… button on the left side of the Drawings tab toolbar to find and open page 1 of the file. 
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The tutorial drawing file named Top of Curb Multipage.pdf is found at C:\Users\Public\Public 
Documents\Vertigraph\SiteWorxOS\Drawing Files. Click the Drawings button on the far left side of 
the Open Drawing File window to display the files in this Drawings folder. After finding the Top of 
Curb Multipage.pdf file, click on the file name to display the preview image on the right side of the 
window. If the drawing preview does not display, click the Show Preview tool   on the top right side 
of the Open Drawing File window.  
 
When working with files that contain multiple pages, the page number is displayed underneath the 
preview at the bottom right side of the window   . Simply navigate through the pages using the 
up and down arrows to preview the desired page. This tutorial project uses one file with multiple pages. 
As a result, after the page 1 preview displays, click the OK button at the bottom to open and display 
page 1 of the drawing.  
 
The active drawing file name and location are shown on the status bar at the bottom right hand side of 
the window. Additionally how the file is rendered (i.e. either as a PDF, Raster, PDF (Vector), CAD or 
ACRO) is also disclosed in the bottom right corner on the status bar.  This multiple page file is a vector 
type PDF file and as a result, will display PDF (Vector) on the bottom, far right corner of the status bar. 
 
 

 
 
Projects may contain a single drawing file or multiple drawing files or pages. In this tutorial, the 
proposed elevations are found on page 1 and the existing elevations are found on page 2. As a result, 
page 2 of the file must also be opened and this tutorial project will use Multiple drawings. To open page 
2 of the file, click the Open… command on the Drawing section of the toolbar, select the same file and 
change page 2 at the bottom right hand corner of the window. In this tutorial, after page 2 is displayed, 
click OK to add page 2 to the Active Drawing list. 
 
Please note there is another way to add pages to a multiple page project. After opening the first page, 
right click the mouse over the drawing to display the pop up menu: 
 

 
 
To add a new page, click on Duplicate Drawing and then move the mouse up to the Page section of the 
toolbar and change the page number displayed on the toolbar to 2.  
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The list of pages or drawings opened and available are displayed by clicking the Active Drawing 
button on the top left side of the Drawings toolbar. Page 1 and page 2 should now be shown on the 
Active Drawing list. Once the desired drawings or pages are opened and properly displayed on the 
Active Drawing list, DO NOT change the Page number since changing the page number will change 
the active drawing. To prevent changes to the page numbers on the Active Drawing list, click the Lock 
button. The page is automatically locked however once the scale is set or whenever the page is aligned 
to the other sheets. Once locked the page number cannot be changed unless it is first unlocked.  

Step	2	‐	Review	the	drawing	files	before	starting	
 
After the desired drawings are opened, review the drawings by selecting the file or page from the Active 
Drawing list to obtain a basic understanding of the project. To review a page that is not on the active 
drawing list, right click on any drawing at the Drawings tab and select Duplicate Drawing from the 
popup menu and then change to the desired Page on the Page section of the toolbar.  
 
IMPORTANT – Zooming and moving around (i.e. panning) the drawing quickly and easily is critical. 
Zooming in and out is done through the scroll wheel on the mouse. When zooming with the scroll 
wheel, the drawing will center on the screen wherever the mouse pointer is placed. The Zoom to 
Selection tool at the Zoom/Pan section of the toolbar is also a quick way to zoom. When zoomed in, 
move (i.e. pan) around the drawing by holding the Ctrl keyboard key down while moving the mouse 
with the left mouse button pressed. Holding down the scroll wheel while moving the mouse also pans 
the drawing.  
 
When reviewing the file, determine the area of interest or project boundary where cuts or fills will 
occur. Where are the existing and proposed elevations different? Are there excluded areas?  Does 
anything need to be demolished and removed? Are project dimensions in meters or feet?  Are there bore 
logs that need to be entered? Is there a known dimension available for auto-scaling?  Are the areas flat 
or not flat? What subgrade material layers need to be placed under the areas? Does the grading 
information come from one file page or does the data come from multiple file pages? If there is more 
than one file or page, are there two common alignment points displayed on each drawing?   If multiple 
files – are there match lines or common alignment points?  In summary, gain a basic understanding of 
the project by reviewing the page file(s) before starting. 

Step	3	‐	Set	the	scale	
 
When working with multiple pages or files, the scale is set only on the first drawing opened which is the 
first drawing on the Active Drawing list found on the Drawing section of the toolbar.  
 
This first drawing on the Active Drawing list is known as the Base Drawing. To change which page or 
file is the first, base drawing for scaling, select any drawing except the first from the Active Drawing 
list, right click the mouse over the desired drawing and select Make Base Drawing from the popup 
menu.  
 
To set the scale, select the first drawing on the Active Drawing list and then click the Scale button on 
the Scale section of the toolbar.  
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After clicking the toolbar’s scale button, a message may recommend autoscaling. Click OK and the 
scale dialog box disappears.  To insure accuracy, Autoscale should be used on all drawings.  Once 
understood, the Show Autoscale Dialog may be turned off under the Options | Setup menu. 
 

 
 
The scale units are defined as either English or Metric units. For Metric Units, volumes are calculated 
as cubic meters rather than cubic yards and areas are reported as square meters instead of square feet.  
 
To set the scale for this tutorial, select English and click the yellow ruler, AutoScale button, and the 
drawing appears. Single click (do not trace) the beginning and end points of the 255’ blue line at the top 
of the drawing. After clicking the second point, enter the length of the line as 255 in the distance box on 
the toolbar and then click the green checkmark OK button on the Scale section of the toolbar. English 
scale lengths are entered in decimal feet. For example, 5 feet, 3 inches is always entered as 5.25 feet.  
 
After entering the distance and clicking OK, the scale factor is displayed. For English scales, the scale 
factor is equal to the reciprocal of the scale times 12. Rarely does the scale factor created using 
AutoScale calculate the exact number however. For example, if the factor shows 479.87 after auto-
scaling and the scale on the drawing shows 1:40, selecting the 1:40 scale from the drop down list will 
change the factor to an even 480 which is the true and proper factor for an image with a true 1:40 scale. 
It is recommended that the calculated scale factor be compared to the factor that would be generated if 
the scale disclosed on the drawing file was selected from the list. 

Step	4	‐	Align	the	drawings	when	multiple	pages	or	files	are	opened	
 
Many projects consist of a single PDF or DWG drawing file or a single page of a multiple page file. A 
single file or page does not need to be aligned. Other projects may contain data from multiple files or 
pages. This tutorial uses two (i.e. multiple) drawing pages where the existing elevations are displayed 
on page 2 and the proposed elevations are on page 1. As a result of using multiple files, the files/pages 
must be aligned to each other.   
 

 
 
To define the alignment points on page 1, click the Align Dwg command on the Alignment section of 
the toolbar at the Drawings tab. When the drawing appears, click on two common alignment points. For 
this tutorial project move to the top left corner of the drawing and single click the corner inside the 
conveniently placed A circle. Next, move to the bottom right corner and click inside the B circle. After 
clicking the two alignment points, move to the Align section of the toolbar and click the green 
checkmark OK button to complete. The alignment points are displayed overtop of the drawing at the 
Drawings tab. The red mark reveals the first alignment point, the blue mark shows the second 
alignment point. After page 1 is aligned, change to page 2 by clicking Active Drawing on the Drawing 
section of the toolbar, click Align Dwg. and align page 2 to page 1 by clicking on the same two 
alignment points in the same manner.  
 
Alignment points should generally be top left and bottom right of an identifiable object. In this tutorial 
the alignment points are conveniently noted as A and B. Sometimes alignment points are not as obvious 
as this tutorial. For other projects, the top left and bottom right corners of a slab, parking area or 
property limits may be ideal alignment points. The alignment points must be common on all of the 
drawing files or pages. Again, each project has unique alignment point locations that must be digitized 
when a project uses multiple files or pages.  
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The alignment points are required when there are multiple drawings with the same footprint. Sometimes 
multiple files/pages will display a match line with different footprints. For drawings with match lines, 
some customers use RasterStitch which stitches together multiple files along the match lines to create 
one large, single drawing file. The entire project will be taken off using this single large drawing file 
created with the RasterStitch software. Information on RasterStitch is found at 
http://www.vextrasoft.com/rasterstitch.htm. In addition to RasterStitch, there are other commercially 
available software products that stich together multiple pages along the match lines.  
 

Step	5	–	Assign	Reference	Points	when	Importing	or	Exporting	Elevations	
 
Setting reference points are not required.  However, if reference points are recorded to the drawing file 
at the Import/Export section of the Drawing toolbar, GPS information can be imported or exported.  
Reference points are used to link the drawing file to real world GPS coordinates when exporting surface 
model points, exporting the takeoff as a DWG file or importing GPS points from a CSV file. 
 
Preferably, two reference points are defined. The points define the scaling and rotation information 
necessary for the export/import.  If only one point is available, the North/South direction must be 
defined. For each reference point, the northing and easting distances from the origination point must be 
entered. Negative northing and easting values indicate a position due south and west of the origin, 
respectively. 
 

Step	6	–	Save	the	File	
 
When done scaling and aligning the drawings at the Drawings tab, save the file by clicking the File 
menu/icon command found at the top left corner of the window followed by the Save Project 
command. Please note that changes to the project file are not automatically recorded. Data is initially 
stored in memory until the changes are saved to the file.   
 
Please note that a backup file is created during calculations.  This backup file will be located in the same 
folder as the original project file.  The original SiteWorx/OS project file has a ves extension.  The 
backup file will have the same name with a ~ves extension.   When using the Windows File Explorer 
application (access File Explorer by right clicking on the Windows Start button) insure that File name 
extensions checkbox is checked under the View menu.  To use the backup you’ll need to rename the 
backup file.  To rename the backup file, right click on the file in File Explorer and select Rename where 
you’ll adjust the file name and delete the “~” character in the file extension.  
 
 

F. Takeoff	Tab	

 
The Takeoff tab is where the data from the drawing files are input into SiteWorx/OS. When building 
the project file, the majority of time is spent at this Takeoff tab.  

Step	7	–	Understand	the	Takeoff	Tab	Toolbar	
 

 

Understanding how the takeoff toolbar works is critical. The sections of the toolbar will be discussed 
moving from left to right.  The various section names are written at the very bottom of the toolbar. 
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Select 
 
The left side of the toolbar is where you change and select the Active Drawing from the list when using 
more than one file or page.  
 
The button underneath the Active Drawing button with the drop down arrow displays the list of takeoff 
objects available for selection.  
 

 
 
The takeoff process involves selecting the object from the list and then recording the relevant data from 
the drawing file pertaining to the selected object.  
 
Takeoff 
 
After selecting the object from the list, move to the right along the toolbar and select the Takeoff type. 
The takeoff type will be either Include or Exclude for regions (a region is a project boundary, topsoil 
strip or topsoil respread area). The Takeoff for all other objects will be either Existing or Proposed.  
 
Display 
 
Whatever is selected as the Takeoff to the left, the Display section of the toolbar provides the option to 
display only the selected takeoff type noted to the left or both takeoff types. When Both are selected for 
elevation items, the screen will display the existing and proposed elevations for the object at the same 
time. If a region object is selected (i.e. project boundary or topsoil), Both displays the included and 
excluded regions.  
  
Elevation 
 
For objects that require elevations (i.e. contour line, point elevation, design line and area elevation) the 
elevation of the object must be input on the toolbar whenever the Options menu | Show 
Properties/Elevation Dialog command is turned off. Normally the Options menu | Show 
Properties/Elevation Dialog command is turned on (i.e. checked) where a dialog box will be presented 
and the elevation and other information is recorded after clicking a point.  
 
Next to the elevation box, a step value is entered and is usually input with a value of 1. When clicking 
the increase or decrease elevation command from the right mouse popup menu or by using the keyboard 
shortcut keys, the elevation will change by the value in the step box. The step value is useful for taking 
off contour lines. Instead of typing in the elevation for each new line, it is quicker to increase or 
decrease the elevation by the step value.  
 
Action 
 
Action tools on the toolbar are important.  
 

   Start Takeoff must be clicked to digitize objects. The mouse will change from a typical mouse 
pointer to one of the following: 
 

     This mouse pointer is used to digitize pixels on screen and is the typical method to 
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record items from a raster file. This mouse pointer displays when working with raster files and 
both Auto Trace and Easy Trace are turned off. When working with Vector or CAD files, this 
cross-hair displays when the Select Entity and Snap to Entity Point commands are off.  
 

 The mouse pointer changes to this shape when Auto Trace is turned on under the 
Raster/PDF menu.  Auto Trace is available only for raster type files and is not offered on 
vector type files.  The background color must be defined by clicking on the file background 
after selecting the Raster/PDF | Background Color command.  Auto Trace is useful when 
recording contour lines from raster type files.  Auto Trace draws the line by clicking on three 
points along the contour line (start of line, direction indicator point along the line which is 
approximately 1” from the start of the line point and end of line point). 
 

 The mouse point changes to this shape when Easy Trace under the Raster/PDF menu 
is turned on. Easy Trace is a simplified way of tracing lines from raster files. When 
approaching an intersecting line using Easy Trace, simply click over the line. To use Easy 
Trace, the background color must be defined by clicking on the drawing background after 
selecting the Raster/PDF | Background Color command. 
 

 When working with vector files, the mouse pointer changes to a small selection box 
when Snap to Entity Point or Select Entity is turned on at the Vector PDF or CAD section of 
the Takeoff tab toolbar.  
 

   Stop Takeoff. When the Start Takeoff action is on, this button stops the takeoff and returns the 
pointer to mouse mode. The project can’t be saved if Start Takeoff is activated. As a result, click this 
Stop Takeoff command before saving the file.  
 
 

 Delete last point. If a mistake is made, this button deletes one point with each click. Clicking 
this button ten times in a row deletes the last ten points. Pressing the Alt + Backspace keys on the 
keyboard also deletes the last point. You can change the many shortcut keyboard commands by 
selecting the Options | Setup | Keyboard Shortcuts menu.   
 
 

 Select an Object. To select an object for modification or deletion, click on Select an Object 
from the Action section of the toolbar and move the square mouse pointer over an actual point in the 
object. The object changes color whenever the square mouse pointer is over a point. When the object 
changes color, left click on the point to select the object. For lines, a point is always found at the 
beginning and end of the line. Please note that there may be no points in the middle of the line, the ends 
of the line always contain a point. For areas or regions, a point is always found on any corner. This 
command can also be activated by clicking the right mouse button.  
 
After selecting, the chosen item’s properties are deleted or changed on the far right side of the window. 
After changes are made on the right side of the window, click the green checkmark  on the top right 
side of the window to record the changes. Click the second red X  , located to the immediate right of 
the green checkmark, to delete the entire object.  
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Zoom/Pan 
 

 
 
 

 Zoom to selection zooms and enlarges the selected area. After clicking, hold down the left 
mouse button to zoom over a selected rectangle.  
 
 

 This command activates the zoom commands. After clicking this command, left click the mouse 
to zoom in, right click the mouse to zoom out. Click this tool again to turn off zooming. Zooming may 
be quicker using the scroll wheel on the mouse or by holding down the Shift key on the keyboard while 
clicking.  
 

 Pan enables movement around the drawing. The mouse pointer will change to a hand after 
selecting this tool. Once this tool is activated, click it again to turn off the pan command. Panning is 
usually easier by holding down the Ctrl key on the keyboard while dragging and dropping the mouse 
with the left mouse button pressed. Holding down the scroll wheel on the mouse also pans the drawing.  
 

  Fit Project in Window will resize the drawing so that the Project Boundary fits inside the 
window. A Project Boundary must be input for this command to work.  
 

 Fit Drawing in Window will fit the entire drawing inside the window.  
 
 
Vector PDF Section of Takeoff Toolbar 
 
The Vector PDF section of the toolbar displays whenever a vector PDF file is open and Use Vector is 
enabled at the Options | Setup | Use Vector menu. This Vector PDF toolbar section will not display 
when working with any other file type that is not a vector PDF. Remember, not all PDF files are vector, 
some PDF files are raster formats.  A menu with similar commands, entitled Vector PDF, is also added 
to the Menus section of the toolbar.  
 

 
 
The buttons found on the Vector PDF toolbar section include: 
 

 Display the Layer List button shows the vector file layers on the left side of the screen.  
 

 Display Layer Dialog presents a window of the layers. Normally, when the Display the Layer 
List button is turned on, the Display Layer Dialog is not needed.  
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 Select Layers is used to identify and isolate a layer. After clicking on the Select Layers button 
move the red, square selection box over an object/entity point and once the entity is highlighted, click 
the right mouse button to display the popup menu.  
 

 
 
Here you can hide all other layers except the selected layer. Layers may be added to a display list that 
contains a subset of layers. After using the Select Layers button to isolate the layers, you must turn off 
the Select Layers command on the toolbar before digitizing.  
 
When working with vector PDF files, the user has three options in how the items are taken off from 
vector PDF files: 
 

 1)  Select Entity should be turned on when working with contour lines. When clicking on the 
line, the entire contour polyline will be selected when Select Entity is depressed.  
 
 

 2)  Snap to Entity Point snaps to a single point within the entity/object. Snap to Entity Point 
is ideal for taking off areas. Snap to Entity Point is often the best way to digitize areas from vector 
PDF files. If contour lines consist of many sections rather than a single polyline, this command is ideal 
for contour lines.  
 

3)  When Select Entity and Snap to Entity Point are both turned off, the items on the screen 
are digitized just like any other raster file.   

 
 

CAD Section of Takeoff Toolbar when CAD, Vector files are opened 
 

The CAD section displays whenever a Computer Aided Design (CAD), vector type file is opened. CAD 
file extensions include DWG, DWF and DXF. For other file types opened, the CAD section of the 
toolbar will not display. Whenever a CAD file is opened, a CAD menu is added to the Menus section of 
the toolbar.  
 

 
 
The commands found on the CAD section of the toolbar are similar to the Vector PDF toolbar commands 
noted above except that an additional command is found on the CAD toolbar that imports the select layer 
information into the takeoff.   This import from drawing command is extremely valuable when working 
with CAD files (i.e. DWG files primarily) and is covered in the chapter entitled “Importing objects and 
elevations from DWG files”. 
 
 



15 

 
Raster/PDF Section of Takeoff Toolbar when raster files are opened 
 

 
 
Three commands are found on the Raster/PDF toolbar: 1) Enable Auto Trace 2) Enable Easy Trace and 3) 
Select Background Color. These commands are useful when taking off contour lines from raster type 
files.  SiteWorx/OS looks for the contrast between the line color and the background color.  As a result, 
the background color must be defined before using Auto Trace or Easy Trace. Once the background color 
is defined, and with a little practice, Auto Trace takes off the whole line with three clicks: 1) start of the 
line 2) an inch away along the line to define the initial direction of the line and 3) end of line. 
 
Easy Trace, on the other hand, matches the digitized line to the plan by dragging the mouse near the line 
with the left mouse button held down.  
 
Menus 

 
Eight menus may be available on the right side Menus section of the Takeoff tab toolbar: Takeoff, 
View, Options, Help, Checking and Reports. Additionally one of three file type menus will be added.  
A Vector PDF menu is added when a vector PDF file is opened. A CAD menu is added and available 
whenever a vector, type computer aided design file is opened such as AutoCAD DWG. And finally, a 
Raster/PDF menu is available when the file opened is a PDF type raster file or another type of raster 
file.  Click on the menu with the mouse pointer to view available commands. As noted previously, click 
on the Help button  in the top right hand corner of the window and then click on the menu with the 
question mark mouse pointer to learn about the various sub-menus.  
 

Step	8	‐	Digitize	the	Project	Boundary		
	

	
 
The process for defining the project boundary follows: 
 

 Insure that Page 1 is the Active Drawing in the Select section of the toolbar. Select Project 
Boundary from the Select list box found underneath the Active Drawing button. Next, click on 
Include at the Takeoff section of the toolbar which is to the immediate right of the Project 
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Boundary selection. The cut and fill volumes are limited to the included area.  
   

Please note: although there are no excluded project boundaries in this tutorial, SiteWorx/OS can 
exclude certain regions from the included project boundary by selecting Exclude and then 
digitizing the excluded region inside a previously digitized Included Project Boundary. Excluded 
regions must be contained within included regions.  
 

 The Project Boundary is where the cuts and fills are calculated. Inside the project boundary 
existing elevations should be different from the proposed elevations. Again, no cuts and fills are 
calculated outside the included project boundary. 

  
 The included project boundary is the region where the proposed elevations are different than the 

existing elevations. The project boundary is normally defined on the file or page that contains 
the proposed elevations.   

 

 To digitize the project boundary, click the lightning bolt Start Takeoff button  
located at the Action section of the toolbar. The mouse pointer will change to a cursor 
crosshair when Select Entity and Snap to Entity Point are not selected on the Vector 
PDF section of the toolbar.  

 
 Now, click on any corner of the blue project boundary line and click on each change of 

direction (i.e. corners) while moving around the project boundary either clockwise or 
counterclockwise. A Region Properties dialog box will display after clicking the first 
point where information about the project boundary is entered. At the dialog box, 
change the line width to 4 and click the OK button. Please note, this dialog box displays 
only when Show Properties/Elevations dialog is checked under the Options menu on 
the toolbar.  

 
 To digitize around a curve, simply click in small increments around the curve or press the right 

mouse button and select the Arc command followed by a click along the curve and another 
click at the end of the curved line. The Arc command is also activated by the keyboard 
shortcut of Alt + A which is defined under the Options | Setup | Keyboard Shortcuts… 
menu.  

 
 When done digitizing the last corner of the project boundary, press the right mouse button Stop 

Takeoff command. The area will close to the first point digitized and the mouse pointer will 
change to a typical mouse pointer rather than a crosshair cursor.  

 
 After stopping the takeoff, information about the project boundary is found on the right side of 

the screen. 
  

 After digitizing the project boundary it is a good idea to verify that the project boundary is 
properly placed over all the drawing files.  Change the drawing files by clicking on the Active 
Drawing selection on the toolbar. 

 
 The Align Grid button at the Grid section of the toolbar is not used with this tutorial. For future 

knowledge and use, the Align Grid button aligns the grid to a side of the project boundary or to 
a selected point. Aligning the grid may be required when exporting stake or GPS data. If the 
grid is not shown overtop the drawing, click on the View menu | Takeoff Grid to display. The 
grid size spacing is set at the Calculations tab. After clicking the Align Grid button, the 
project boundary can be aligned with the grid lines or to a selected point, such as a slab 
corner. If aligning the grid to a point, make sure the desired point has been recorded as a 
Point Elevation at the Select section of the Takeoff tab toolbar. Then at the Point Elevation 
window select the desired point using the Select an Object tool from the toolbar . After 
selecting the point, select the Project Boundary and press the Align Grid button to align the 
grid to this selected point.  
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Step	9	‐	Digitize	Contour	Lines		
	
After digitizing the Project Boundary over the proposed elevations on Page 1, click the Active Drawing 
button on the toolbar to change the drawing to page 2. The existing contour lines on the drawing file 
and the project boundary should now display.  
	
Select Contour Line from the list box on the Select section of the toolbar. Next, select Existing as 
the Takeoff and type in 98 in the Elevation box with a Step value of 1.  The Display section of the 
toolbar should be set to Takeoff, not Both. 

 
When working with a vector file, the contour lines can be taken off in three different ways:  
 

1) Click along the line with the mouse by clicking on the change in direction inflection 
points.  

2) Use the Select Entity tool where the contour line from a vector file is taken off with a 
single click.  

3) Use the Snap to Entity Point tool with vector files where the mouse pointer will snap 
to points contained in the line.  

 
This tutorial will demonstrate all of the methods noted above. Item 1) is often used when working 
with raster files. Additionally, when a raster file is loaded, you can also takeoff contour lines by 
using the Auto Trace or Easy Trace features.  When performing the takeoff you’ll determine which 
method is best for the specific drawing file. On many projects, employing more than one method 
is common.  
 
Method 1 – Click along the line 

 
First, using method 1 noted above, please insure that the Select Entity and Snap to Entity Point 
buttons are not on or depressed at the Vector PDF section of the toolbar. Also the Elevation should 
be at 98 and the Step should be 1 at the Elevation section of the toolbar.  Next click the   Start 
Takeoff button on the Action section of the toolbar to begin digitizing. Click the end of the 98 existing 
contour line located at the bottom right corner, and the Contour Line Properties dialog box will 
display whenever the Options menu | Show Properties/Elevation dialog is checked.  

 

   
 

Since the contour lines are changing in foot increments, it is quicker to change the elevations by using 
the step value defined on the toolbar rather than typing the elevation in the contour line properties box 
for each line. As a result, check the “Do not show dialog” check box at the very bottom of the window 
then click OK to close the window. Click on the change of direction along the 98 foot and when done 
digitizing along the 98 line, increase the elevation value by the step value by right clicking the mouse 
and selecting, on the right side of the popup menu, Increase Elevation. The elevation is also increased 
by the step value by pressing the F11 keyboard shortcut key. Elevations are decreased by the step value 
by pressing the F12 keyboard shortcut key. Whenever the elevation is changed the line will end. Next, 
click on the beginning of the 99 elevation contour line and click along the line and repeat the above 
same steps.  

 
Practice digitizing the contour lines using method 1 from the bottom right corner up to the 103 elevation 
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line while using the right mouse button or F11 and F12 keyboard keys to increase and decrease the 
elevations.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Please remember, zooming is best done using the scroll wheel on the mouse and moving around the 
drawing (i.e. panning) is performed by holding the keyboard Ctrl key while dragging the mouse. 
Practice moving around, panning, changing elevations and recording contour lines.  

 
Please note that if you digitize incorrect points, click the Delete last point button on the Action 
section of the toolbar or press the Alt+Backspace keyboard shortcut keys. To end one line and start a 
new line with the same elevation, right click the mouse and select New Object from the popup menu. 
After digitizing the 103 contour line, right click the mouse and select Stop Takeoff or click the red X  

  in the Action section of the toolbar.  
 
The properties for the last item digitized are shown on the right side of the window. Here the elevation 
and/or other properties can be changed or the entire line can be deleted. To record any changes made on 
the right side of the window, click the green checkmark on the top right side of the window . To select 
a contour line for modification or deletion, click on a point within the line (please note that points are 
always found at the beginning and end of every contour line) using the Select Object tool  from the 
Action section of the toolbar. To delete the selected line displayed on the right side of the window, click 
the red X button  located to the right of the green checkmark on right side of the window.  
 
   
Method 2 – Select Entity 
 
When done with the 103 elevation line right click the mouse and select Stop Takeoff. The remainder 
of the existing contour lines will be digitized using the Select Entity feature as noted in method 2) 
listed previously. Now that some of the existing contour lines have been recorded using the raster file 
takeoff method, the remaining contour lines will use the select entity, vector file method.  
 
To digitize the proposed contour lines with the Select Entity setting, insure Select Entity  is clicked 
on the Vector PDF section of the toolbar. Finally, type in the elevation at the Elevation section of the 
toolbar and make sure the Step value is set to 1. Now click Start Takeoff on the Action section of the 
toolbar to begin.  
 
The mouse pointer will display a box when Select Entity is turned on. Move the box over the 104’ 
contour line and left click on the line to takeoff the entire line. When done, right click and select 
Increase Elevation or use the F11 keyboard key to increase the elevation by the set value to 105’. 
Click the 105’ contour line to takeoff the entire line. Continue to increase or decrease the elevations 
using the right mouse button popup menu or by using the F11 and F12 keyboard shortcut keys. Once 
the proper elevation is defined at the Elevation section of the toolbar, single click on the desired 
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contour lines to takeoff the entire line. You’ll find that using the Select Entity tool from the Vector 
PDF section of the toolbar is more accurate, faster and much better than digitizing pixels on-screen.  
 

 
 
When done with all of the existing contour lines, click Stop Takeoff from the right mouse button 
popup menu or from the Action section of the toolbar and then change the Active Drawing to Page 1 
and digitize the proposed contour lines.  Remember the Takeoff should be changed to Proposed on the 
toolbar ribbon. 
 
When the contour lines are a collection of segmented lines rather than a single polyline, the Snap to 
Entity Point command should be turned on at the Vector PDF toolbar.   
 
Method 3 – Snap to Entity Point 
 
When taking off contour lines from vector files, Select Entity is usually the preferred method. 
Sometimes however, the creator of the drawing file improperly creates a collection of section lines 
along the contour line rather than a single polyline. If you come upon a contour line that contains 
many small lines or entities, change from Select Entity to Snap to Entity Point on the Vector PDF 
section of the toolbar. Additionally, the Append line segments command at the Vector PDF section of 
the toolbar can also be used with the Select Entity command when digitizing line segments. 
 
Snap to Entity Point is also the preferred method to takeoff areas from vector files. As a result, 
this Snap to Entity Point takeoff method will be demonstrated when recording the proposed areas.  

Step	10	‐	Record	Points		
	
The page 1 of the Active Drawing contains point elevations.  Select Point Elevation from the Select 
section of the Takeoff tab toolbar. Click Proposed as the Takeoff type. Turn off the Select Entity and 
Snap to Entity Point commands on the Vector PDF section of the toolbar. When taking off points, 
please turn on the Options menu | Show Properties/Elevation Dialog.   Finally, click the Start Takeoff 
button to begin digitizing.  
 
The 103.23 point elevation is located in the top left corner of the window below the A alignment point. 
Simply click on the point and then enter the elevation followed by the Enter key on the keyboard. Using 
the keyboard, rather than the mouse, to record elevations into the Properties/Elevation Dialog generally 
increases your data entry speed. Digitize the top of curb elevation points around the parking lot. When 
done digitizing all of the point elevations, click the right mouse button Stop Takeoff command to 
return to mouse mode.  
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Step	11	‐	Record	Sloping	Design	Lines	
 
Design lines define slopes and smooth out the site. A design line is a sloping line where the end points 
will have different elevations. Between the end points, a series of increasing or decreasing elevation 
points will populate along the design line. Points found in contour lines and point elevations that are 
closest to the design line will connect to the points created along the design line. In this tutorial, design 
lines are being used to define the slope of the parking lot. On many projects, design lines are not 
needed since the contour lines and point elevations will properly model the surface. Users may 
determine that design lines are needed in certain locations after looking at the 3D model noted at the 
3D View tab. 
 
When recording a Design Line, the Show Properties/Elevation Dialog under the Options menu should 
be checked on. After selecting Design Line and Proposed Takeoff from the Takeoff tab toolbar, click the 
Start Takeoff button and after clicking on the end point of the line, type in the elevation, change the color, 
line style and increase the width and press the Enter key on the keyboard. Click on the other end point of the 
line and enter a different elevation followed by the Enter keyboard key. Design lines are often used to define 
the parking lot slopes. Design lines should not cross.  
 

 
 
 
When recording design lines with the Options | Show Properties/Elevation Dialog checked, the 
sloped elevation of the end point may be calculated based on a slope by checking the Pitched check 
box. After clicking the Pitched check box, enter either a rise and run value or a percentage. For lines 
the slope downwards, the slope % or rise value will be negative. This tool is helpful in determining the 
end point elevations of a line with a constant slope.   
 

Step	12	–	Record	Areas	
 
Please note there are four area types:  Surface, Basement, Subgrade Only and Other. Before 
digitizing an area from the plan, please determine the area type.  
 

1. A Surface area, such as a building slab, is for flat areas that are at or above grade at a 
specified elevation.  
 

2. A Basement area type is for flat areas below grade. Surface and Basement areas are 
the same except that a contour line is drawn around the perimeter of a Surface area 
where the elevation points generated from the contour line will slope to the closest 
elevation points outside of the Surface area. A Basement area, on the other hand, 
will be dropped down to the specified elevation, and the walls will be straight up. 
The perimeter of a Basement does not slope or connect to the closest elevation 
points like a Surface area.  



21 

3. A Subgrade Only area identifies non-flat areas, such as parking lots and sidewalks. 
The elevations over a Subgrade Only area are reduced by the subgrade layer depths. 
The varying elevations of a Subgrade Only area are defined by the elevation points 
(i.e. contour lines, point elevations or design lines) previously recorded.  
 

4. An Other area type is used to calculate areas, perimeters and layer volumes. Other 
areas have NO effect on the 3D model or the cut and fill volumes. Other is used for 
measuring only.  

 
Again, before digitizing the area, determine the type of area being taken off. Is it a Surface Area or 
a Subgrade Only area? Again, flat slab areas are Surface areas, flat areas below grade are 
Basement areas and non-flat areas are usually Subgrade Only areas. The Show 
Properties/Elevation Dialog should always be checked under the Options menu whenever 
recording areas.  
 
Digitizing a Flat Surface Area 
 
Select Page 1 as the Active Drawing on the Select section of the Takeoff tab toolbar to display the 
proposed elevations drawing file.  
 
Isolating design layers from vector files eliminates drawing information that is not needed or 
relevant to the current takeoff.  Being able to isolate drawing layers are a key advantage of vector 
type files.  To isolate a vector layer (e.g. the slab on grade) please insure that Display the Layer 
List is turned on at the Vector PDF toolbar. The width of the layer list on the left side of the 
window is adjusted by moving the mouse pointer to the edge of the list and once the pointer 
changes to a double headed arrow, drag the edge of the layer list window to resize.  
 
Click the Select layers button on the Vector PDF toolbar and then move the red square mouse 
pointer over a corner of the building slab. When the perimeter line is highlighted, right click the 
mouse to obtain a popup menu of layer commands.  
 

 
 
To display the selected layer only, select the Hide Other Layers command from the popup menu.  
 
Please note that a subset of layers could be added to a display list by clicking on the Add Layer to 
Display List command. After the desired layers have been added to the Display List, click Show 
Display List to show this collection of layers. The created display list is often used when you want 
to show two or more layers at the same time. For example, a display list could be created for the 
proposed contour lines and elevations.  
 
After the building slab displays, move to the layer list on the left side of the window and turn on, by 
clicking, the check boxes for Slab Annotation, Pkg lot and parking Lot Annotation layers. Four 
layers should now be displayed. Please note, the black square on the top of the left side layer list 
displays all of the layers. The white box at the top, turns off all layers.  
 
When done selecting the desired layers, turn off the Select Layers command on the Vector PDF 
section of the toolbar and click on the Snap to Entity Point command. This area takeoff will 
demonstrate how the Snap to Entity Point method works with a vector file.  
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To digitize areas, select Area Elevation from the Select section of the toolbar at the Takeoff tab. 
Next, select Proposed as the Takeoff. Click Start Takeoff on the Action section of the toolbar and 
then click the first corner of the slab to display the Area Elevation Dialog.  
 
At the Area Elevation Dialog type in 107.33 as the elevation, click proposed and select Surface as 
the Area Type, enter 4 as the Overcut length in feet, enter .33 as the Above Grade value, change 
the color and fill pattern, and finally, Name the area as “Slab on Grade” and then click OK.  
 
 

 
 
To digitize the building area, click on four corners, which will snap to the corner point, either clockwise 
or counter clockwise around the slab, and then press the right mouse button and select Stop Takeoff to 
complete. It is not required to digitize back to the starting point. When stopping the area takeoff, the area 
will automatically close to the first point.  
 

 
 
Any of the information improperly recorded at the Area Elevation dialog may be changed on the right 
side after the area is completed. To save any changes made on the right side, click the green 
checkmark   found on the top right hand side of the window. The entire area can be deleted by 
clicking the red X to the right of the green checkmark. 
 
The material layers under the slab are input by clicking the Layers tab on the right side of the window.  
 
Click the layers tab and create two layers:  Concrete and Select Fill should be typed in the Material 
boxes.  The depth of the concrete should be .5 and the depth of the select fill should be 2 feet.  The select 
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fill should also be applied to the overcut area by checking the Include Overcut box. 
 
   

 
 
 
Please note the following regarding the Layers tab: 
 

 The width of window is changed by moving the mouse pointer to the left edge of the 
window near the up and down scroll bar. Once the pointer changes to a double headed 
arrow, drag and drop the window width.  

 
 To add, delete and record layers, use the buttons at the bottom.  

 
 If the layers are spelled consistently, the layers for all of the areas will be totaled under the 

Reports menu.  
 

 If an area has on overcut value recorded at the Properties window, the material layer can 
be applied to the larger overcut area by checking the Include Overcut checkbox. When 
Include Overcut is checked, the backfill required will also be calculated.  

 
 The layer and backfill volumes are not included in the fill volumes shown at the 

Calculations tab.  
 

 The Reports | Area | Layers report discloses the layer volumes that need to be added to the 
site.  

 
 Layer details may be copied from the last area digitized by clicking on the Options menu | 

Copy Area Layer Info | Always.  
 

 
Digitizing a Non-Flat Subgrade Only Parking Area 
 
To digitize a non-flat area, such as the parking lot or sidewalk, select Area Elevation from the drop 
down list box at the top of the Takeoff window. Next, select Proposed as the Takeoff, click the 
Start Takeoff from the Action section of the toolbar, and click the first corner of the parking lot to 
display the Area Elevation Properties dialog box.  
 
When recording non-flat areas like parking lots, the elevation of the digitized area will be reduced 
by the subgrade layers depth. As a result, elevations are not needed or used for Subgrade Only 
areas. At the Area Elevation Properties dialog box ignore the elevation box and change the 
proposed Area Type to Subgrade Only, change the color, fill pattern and name the area as 
“Parking Lot”.   
 
Simply click on the change in direction as you move clockwise or counterclockwise around the parking 
lot. Click in small increments around the curve at the bottom of the parking lot or input the curved line 
using the Arc command. To activate the Arc command, right click the mouse and select Arc or press 
the Alt + A shortcut keyboard keys. After activating the Arc command, click anywhere along the curve 
followed by a click on the end of the curve. To correct a mistake, press the keyboard Alt+Backspace 
keys. When done, click on the Stop Takeoff command on the toolbar to complete.  
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Please note the following about Subgrade Only areas: 
 

 If changes need to be made, select the area and change any of the information on the right side. 
After changing information on the right side click the green checkmark at the top right  to 
record the changes.  

 
 Click the Layers tab on the far right to enter the layers. Since the elevation points were recorded 

at the top of curb elevations, a layer is required for the height of the curb of .5 feet to bring the 
elevations down to the top of pavement. Another layer will be added for the 2” Asphalt (.17 
depth in feet) and a third layer of .33 depth in feet for the 4” Type II base. When done with the 
layers, click the checkmark at the bottom of the layers window to record the changes. With three 
layers that are a total of 1 foot deep, the proposed subgrade elevations previously digitized will 
be reduced by 1 foot over this area.  
 

 Excluded areas (e.g. planter islands) must also be digitized. After clicking Start Takeoff, 
digitize a point at the dialog box will be displayed.  Here, check the Negative box on the Area 
Elevation Properties dialog, insure Subgrade Only is the area type and click around the planter 
island area. When done, right click the mouse and select Stop Takeoff. Again, if anything was 
not entered properly at the Area Elevation Properties dialog, move to the right side after the 
area is completed and change the properties on the right side. For this negative area, click on the 
Layers tab on the right and record the exact same layers that where entered for the parking lot (i.e. 
.5 height of curb, .17 Asphalt and .33 Type II Base). The layer volumes disclosed for this negative 
area will be subtracted from the parking lot’s layer volumes.  
 

 There is no demolition and removal on this project. If you encounter a job with demolition, 
removing a parking lot or sidewalk from an existing site for example, the area should be taken 
off as an Existing Subgrade Only area and a layer called “remove or demo payment” must 
be added at the Layer tab on the right with the depth of the material to be removed. The volume 
of the parking lot to be removed will be disclosed under the Reports | Area | Layers menu. The 
cuts and fills shown on the Calculations tab are the volumes after the parking lot was removed.  
 

Step	13	–	Record	Topsoil	Strip	and	Topsoil	Respread	regions	
 
If the project requires topsoil to be stripped or respread, these topsoil regions must be identified.  If 
borings are input, the topsoil strip volume is always calculated from the boring log data.  
 
There are two ways to enter topsoil regions:  1) digitize with the mouse the topsoil region and enter 
the depth at the displayed dialog window or 2) select Project Boundary from the Takeoff tab, and 
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copy the entire project boundary as a topsoil region and then exclude areas if required.   
 
 
In this tutorial the project boundary will be copied as a topsoil strip and topsoil respread region. At the 
Takeoff tab Project Boundary selection, select the corner of the project boundary using the select an 
object tool; after selecting, click the right mouse button when the mouse pointer is inside the project 
boundary and select Copy as Topsoil Strip. The Copy Region dialog appears.  
 
 

 
 
 
The above dialog will copy the entire project boundary as a topsoil strip area. Enter a Depth in 
decimal feet or meters (. 5 for 6 inches) with a Fwd Diag. fill pattern. When done filling out the 
dialog box, press the OK button.  
 
Then copy this same project boundary as a topsoil respread region by pressing the right mouse button 
inside the project boundary and select Copy As Topsoil Respread. Enter a depth of .5 and click the OK 
button.  
 
The slab and parking lot previously digitized at the Area Elevation selection will be copied as 
Excluded Topsoil Respread regions as noted in the following steps to arrive at the proper topsoil 
respread volumes.  
 
These copied regions may be edited at any time by selecting Topsoil Strip or Topsoil Respread from 
the Select section of the Takeoff tab toolbar.  
 

Step	14	‐	Copy	Selected	Areas	as	Excluded	Topsoil	Respread	regions	
Since topsoil is not re-spread over the building and parking lot, these areas will be copied as excluded 
topsoil re-spread regions by performing the following: 

 

 At the Takeoff tab, select Area Elevation. Click the Select an Object tool from the Action 
section of the toolbar, and left click on the corner of the slab to highlight and select.  

 After the area is selected, right click the mouse, and select Copy as Topsoil Respread.  

 A copy region dialog box is displayed. Change Include to Exclude on the dialog box, and click 
OK.  

 When done with the slab, select the parking lot and perform the same steps to exclude the 
parking lot as a topsoil respread region. 

 This excluded topsoil re-spread region is displayed when Topsoil Respread is selected and the 
Display section of the toolbar is set to Both.  

 

The takeoff for this limited tutorial is now complete. Calculating the results, reviewing the information 
and printing the reports will be done next. Once the review is completed, the user may need to return to 
the Takeoff tab to select certain items for modification. To change items, select by clicking on the 
desired object first (i.e. contour line, point elevation, etc.) then use the Select an Object tool from the 
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Action section of the toolbar to select the item. Make changes on the right side of the window followed 
by the green checkmark to post the changes. You can also select items for editing by using the 
Checking | Examine menu from the Takeoff toolbar to scroll through all of the number objects 
displayed on the top right side of the window.   

 

To calculate the results, click on the Calculations tab… 
 

G. 	Calculations	Tab	

Step	15	‐	Calculate	the	results	at	the	Calculations	tab	

 
 
Comments about the Calculations tab’s toolbar: 
 

 Click the Calculate button located at the top left of the Calculation tab toolbar to compute.  
 

 The TO Check button on the toolbar checks the takeoff for certain errors.  
 

 At the very bottom of the calculated information, the site balancing adjustment is shown. If 
the proposed elevations are adjusted by this value, the site balances where the subsoil cut 
volume will equal the fill volume and there will be little subsoil import or export. To balance 
the site and change the proposed elevations, click the Balance button on the toolbar. 
IMPORTANT - save the project file as a different name prior to clicking the Balance button 
since the proposed elevations will change and will no longer agree to the proposed elevations 
noted on the drawing file when this Balance button is clicked.   For this tutorial, do not 
balance the site. 

 
 The calculated information may be copied to the clipboard in order to paste this information 

into other programs such as Word or Excel. To copy, click the Copy to Clipboard button on 
the toolbar. Many estimators use Microsoft Excel to apply costs to the quantities (i.e. estimate 
the costs). Open Excel, click on a cell and then paste this information from the clipboard to 
Excel.  
 

 The separator button on the toolbar should be set to Tab when pasting this information into 
Excel. For other programs, a comma delimited separator may be ideal. If the information does 
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note paste properly after clicking the Copy to Clipboard button, change the selection to Tab 
from Comma or vice versa.  

 
Comments about the Calculations tab work area: 
 

 The actual grid lines are displayed at the Takeoff tab when the menu View | Takeoff Grid 
is turned on. The cut and fill volumes for each grid are disclosed at the Grid Data tab. A 
smaller grid results in a more detailed calculation of volumes. Grid size also affects the 
resolution of the 3D image shown at the 3D View tab. The smaller the grid size, the higher 
the resolution displayed at the 3D View tab.  

 
 Topsoil and subsoil expansion and compression factors are recorded at the Calculations tab. 

The Site Swell factor relates to expansion and the Import Swell factor relates to 
compression. Normally these factors are greater than 1 and less than 2. The Site Swell factor 
is multiplied by the bank or tight volumes to arrive at loose cubic yards (LCY). The Import 
Swell factor is divided into the loose volumes to arrive at compressed yards. The Discard % 
for topsoil is deemed to be waste. The percentage of topsoil recorded as waste may be green 
material that dies or topsoil that disappears from the topsoil strip volumes. If you desire no 
swell or compression simply set the factors to 1. For no topsoil waste, set the percentage to 0.  
 

 Topsoil volumes are displayed at the Calculations tab only for jobs that do not use boring 
logs. If boring logs are setup at the Project tab, the topsoil strip volumes, as defined by the 
boring logs, are shown at the Reports | Cut by Soil Type menu.  

 
 The Resolution setting affects the size of the each square on the 3D View and the amount of 

calculations that are performed. Calculations are performed for each grid square. Each grid is 
subdivided into smaller calculation squares. As a result, more squares result in more 
calculations. The total number of squares increases when the grid size is reduced. The number 
of squares also increases when the resolution setting is increased. The following are the number 
of squares for each grid box for the resolution settings: 

 
 Low – 100 squares per grid box (10 x 10) 
 Medium  - 625 square per grid box (25 x 25) 
 High – 2,500 squares per grid box (50 x 50) 
 Very High – 10,000 squares per grid box (100 x 100)  

  
Very High resolution is only available in the 64 bit version of SiteWorx/OS. The resolution 
setting truly affects the detail and number of calculations. As you can see, Very High resolution 
creates 100 times more detail and calculations than Low resolution.  
   
For speed and ease of use, first calculate using the Low or Medium Resolution setting. After 
calculating, review the results and look at the 3D View tab to verify the takeoff. If the 3D View 
tab and numbers look reasonable, recalculate using High or Very High resolution for final 
results. The higher the resolution, the more calculations performed in SiteWorx/OS and the 
longer it takes. If the grid size is too small with Very High resolution, the calculation time may 
be excessive. To speed up the process, increase the grid size and/or reduce the resolution 
setting.  
  
The Grid Size and Resolution interact to have an effect on the accuracy of the calculated 
volumes. Increasing Resolution decreases the size of each square calculated. With a 50' grid, 
Low Resolution calculates on 5' X 5' squares. High Resolution calculates on 1' X 1' squares.  

 
 

 Calculated results are shown to the right of the screen. Information is broken out by 
topsoil and subsoil volumes. The left column displays the tight, bank volumes before 
swell factors. The right column shows the loose volumes after applying the swell factors.  

 
 Total Cut = Subsoil Cut + Topsoil Strip 

 
 Total Fill = Subsoil Fill + Topsoil Respread 

 
 IMPORTANT PLEASE READ – At least one existing and proposed elevation point must 

be entered in order to properly calculate the volumes. An elevation point is either a contour 
line (a contour line generates a series of equidistant points along the line with the same 
elevation), a point elevation or a sloping design line. SiteWorx/OS calculates volumes and 
develops a 3D model of the existing and proposed site based on the elevation points entered. 
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The elevations points, created from the contour lines, point elevations or design lines, are 
connected to each other to develop the 3D model. Areas are then placed on top of this 3D 
model as a plane. SiteWorx/OS develops an existing and proposed surface model from the 
items digitized. Again, at least one existing and proposed point must be input. And areas 
don’t count.  

 
 The total cut and fill volumes are calculated based on the differences between the existing and 

proposed elevations (i.e. differences between the existing and proposed surface models). If the 
proposed elevation is higher than existing for a grid square, the volume for that square is 
calculated as a fill volume. Likewise, if the proposed elevation is lower than existing 
elevations for a resolution grid square, the volume for that square is defined as a cut volume. 
After calculating the cut and fill volumes, the topsoil strip and topsoil re-spread volumes are 
subtracted to arrive at the Subsoil cut and fill volumes.  

 
 At the bottom of the window, SiteWorx/OS discloses the site balancing adjustment required 

that balances the site where the subsoil cut volume equals the fill volume.  
 
 
After calculating, click on the 3D View tab to review the models… 
 
 

H. 	3D	View	Tab	

Step	16	–	Review	the	models	at	the	3D	View	tab	

	

	
	

 The quality and resolution of the 3D view is determined by the grid size and resolution setting 
at the Calculations tab. A smaller grid size and a higher resolution setting increases the quality 
of the 3D view. 
 

 When Manipulate is set to none, clicking on any point on the 3D model will display existing 
and proposed elevations at that point along with the cut or fill depth. 

 
 The 3D style is best for displaying the Existing and Proposed data. The Plan style is ideal 

for showing the Cut/Fill data.  
 

 Display OB will show the image outside the project boundary. Existing elevations can go 
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outside the project boundary. Proposed elevations stop at the boundary line. When Display 
OB is depressed with the Proposed Data, the proposed site will be placed on top of the 
existing site to show how the proposed elevations affect the existing site at the project 
boundary.  

 
 Show Mesh displays the square lines. When using a high resolution setting, the image may be 

dark due to the many squares. To improve the view, increase the size of the 3D view by 
zooming using the manipulate commands or turn off the Show Mesh setting.  

 
 The drop down list box in the Manipulate part of the toolbar allows the rotation and resizing of 

the 3D view. If the Rotate and Zoom manipulate option is selected, zoom the image by holding 
down the right mouse button while slowly dragging the mouse from the center. Rotate the image 
by holding down the left mouse button while slowly moving the mouse.  
 

 The Z% exaggerates the Z scale when increased. The Z% should be set to 100 to display the 
3D view to scale. To display the elevations disproportionately, increase the Z% value to 200 or 
more.  

 
 The reset button resets the image to the default values.  

 
 Elevation errors are clearly displayed at the 3D View tab. Look at the legend at the bottom of 

the screen. Are there any spikes? Is the existing or proposed site all one color and is the range 
of elevations on the bottom legend reasonable? A 0 elevation on the left side of the legend often 
indicates that an item was digitized without an elevation. Click the Checking | Examine menu 
at the Takeoff tab to find incorrect elevations.  

 

  On any project, click on the 3D View tab periodically to insure that the existing and proposed 
sites look reasonable. 	

  

I. Review	and	make	adjustments	

Occasionally incorrect elevations and data may be recorded. The 3D View tab will clearly display 
problems. Does the 3D View tab show spikes? Does the range of elevations on the legend at the bottom 
of the 3D View window look correct?  Does the existing, proposed and cut/fill models look reasonable?  
If any of the 3D models do not appear proper, something is wrong. If there is an error, try to determine 
if the error is due to an incorrect elevation point, contour line, area, or design line? The Review 
selection at the Takeoff tab displays the data in relationship to other selected objects.  

 

To find and correct the error, perform the following: 

i. Go the Takeoff tab, select and display any of the takeoff objects (i.e. Contour Line, Point 
Elevation, Area Elevation, etc.).  

ii. If the error is obvious, select the object by clicking on an object’s point (end of contour line or 
corner of area) using the Select an Object tool   and then change the incorrect data on the 
right side.  

iii. At the Takeoff tab, the Checking | Examine menu is helpful for finding unreasonable 
elevations and errors. Click Checking | Examine menu and then Checking | Above Maximum 
and Below Minimum to find items that are above or below the max and min settings. The min 
and max settings are set at the Checking menu | Min or Max Elevation.  

iv. If the item causing the error is not obvious, look at all of the digitized objects by clicking the 
Checking | Examine menu. All objects are assigned a number with SiteWorx/OS. When 
Checking | Examine is turned on, the object’s number will be displayed on the top right side of 
the window. Simply scroll through the numbered objects by clicking the arrow buttons to find 
the object causing the problem.   

v. After selecting the object, the right side of the window will display the properties of the selected 
object which may be changed and deleted. Click the  green checkmark to save any changes.  
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vi. To delete an object, click the  Delete selected object tool located on the right side of the 
window and to the right of the  green checkmark.  

vii. The width of the properties window on the right side may be resized by holding down the left 
mouse button while dragging the mouse once the mouse pointer changes to a double headed 
arrow at the left edge of the properties window (i.e. between the drawing and the properties 
data).  

viii. When reviewing the objects, please insure that the elevations are accurate, the takeoff type is 
correct (i.e. existing or proposed) and the areas are properly defined. Areas that are not flat are 
normally Subgrade Only areas; flat areas are either Surface or Basement areas. When looking 
at Surface and Basement Area Elevation objects, the actual elevations are shown at the 
Corners tab. Also insure the subgrade materials are properly recorded at the Layers tab for 
each area.  

 

After making the changes, save the file and look at the effects at the 3D View tab.    

 
 

J. 	Cross	Sections	Tab	

 

	
 

 The project boundary with the grid lines are displayed on the left side of the Cross Sections tab. 
As noted previously, the grid spacing is set at the Calculations tab. To display the existing and 
proposed elevations at the northwest corner of each grid, simply click on the grid box.  

 

 The top right image shows the location of the cross section line running from left to right.  

 

 The bottom right image displays the cross sections from bottom to top.  

 

 The existing and proposed lines meet at the project boundary.  

 

 The existing elevation line may be shown before or after the topsoil strip depth by clicking the 
After Strip button on the toolbar. The proposed elevation line can also be set before or after the 
topsoil respread depth.  
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K. 	Grid	Data	Tab	

To the right of the Cross Sections tab is the Grid Data tab.  
 

 
 
 

 The cut and fill volumes for each grid is shown at the Grid Data tab. The grid is displayed on 
overtop of the drawing file at the Takeoff tab by clicking on the View | Takeoff Grid menu. 
The grid size is set at the Calculations tab. Two different data displays are available, Cut/Fill 
and Stake.  

 
 The Cut/Fill display is shown above. The Cut and Fill volumes consists of the topsoil 

volumes and the subsoil volumes. Like the calculations window, Total Cut = Topsoil Strip + 
Subsoil Cut and Total Fill = Topsoil Respread + Subsoil Fill.  

 
 The stake height adjustments for each of the four corners of the grid may be before or after 

topsoil strip. To change the stake heights, click on Before Strip or After Strip on the 
toolbar. The notation of O. B. for an individual corner indicates the corner is outside the 
boundary.  

 
 The Stake report provides the coordinates of the northwest corner of each grid. At this point, 

the existing elevation, proposed elevation and the depth of the cut and/or fill is provided. As 
noted previously, the grid can be aligned to the project boundary or to a specific point. To align 
the grids with a certain coordinate, see Step 8 - Digitize the Project Boundary.  

 
 The data on the Grid Data tab may be exported to a number of formats by clicking the 

Export button.  
 

 Surface points may be exported as a DWG file by clicking the Export Surface command. Prior 
to exporting GPS data, assign two reference points at the Drawings tab.  The Export DWG 
command, creates a DWG file of the contour lines, points and areas previously recorded. 	

	

L. 	Soil	Analysis	Tab	

Since this tab relates to boring logs, this Soil Analysis tab will be covered under the Boring Logs 
chapter.  
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M. 	Trenches	

SiteWorx/OS also calculates trench volumes. The cut and backfill volumes from trenches are reported 
separately and are NOT included in the cut and fill volumes displayed at the Calculations tab. After 
digitizing the trenches, view the trench information and volumes, by selecting Trench and Trench 
definition from the Reports menu.  
 
SiteWorx/OS develops a model of the proposed site based on the proposed elevations digitized. The 
trenches are then dug from the proposed elevations to arrive at the trench volumes.  
 
To digitize a trench, select Trench from the list of objects on the Takeoff tab toolbar and insure the 
Show Elevations/Property Dialog and the Show Trench Definition Dialog are turned on under the 
Options menu. Next, at the top of the screen, enter the invert elevation for the beginning of the trench. 
The invert elevation is the trench elevation at the bottom of the trench. Click the Start takeoff, lightning 
bolt button and the Define Trench dialog box appears.  
 

 
	
Please note: 

	
 Define the line colors, width and type of trench. SiteWorx/OS handles three types of trenches: 

V Bottom Drain, Flat bottom Drain and Pipe Conduit trenches. After selecting the trench type, 
click on the dimension boxes and enter the various dimensions.  
 

 When clicked on a dimension box, the measurement required will be displayed in red on 
the left side under the Schematic tab.  

 
 After all dimensions have been entered at the Schematic tab, the cross section of the trench 

based on the dimensions actually entered will be displayed at the Actual tab. Once the trench 
has been defined, press the OK button. Next, digitize the next point along the trench line.  

 
 Whenever any two invert elevation points are recorded, SiteWorx/OS can calculate the 

invert elevations of the other points digitized by applying the calculated slope between those 
two points. A trench requires a minimum of two bottom of trench points with elevations. The 
elevations of all other points can be calculated based on the slope between the two known 
points. This is accomplished by checking the Calculate Invert Elevation checkbox found 
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on the elevation dialog box. In summary, enter the actual inverse elevation in the Inverse 
Elevation box or calculate the elevation by checking the Calculate Inverse Elevation 
checkbox. To use the Calculate Invert Elevation checkbox, the actual elevation must be 
entered in two places along the line: at the start of the trench and anywhere else along the 
trench line. In this example, click the Calculate Invert Elevation check box on all trench 
line points except the first and last points on the trench line.  At the end of the trench, the 
actual invert elevation will be entered at that point and the calculate invert elevation 
checkbox will be unchecked. 

 
 After digitizing or calculating the elevations of the trench, press the right mouse button and select 

Stop Takeoff to complete.  
 

 Once complete, view and print the trench reports under the Reports menu. Again the trench 
volumes appear only on the Reports menu | Trench …. The trench volumes are not included in 
the site excavation cut and fill volumes displayed on the Calculations tab or on the other 
reports.  

	

N. 	Summary	and	review	the	reports	

 

In summary the takeoff process with SiteWorx/OS works as follows: 
 

1. Complete the Project Tab 
2. Open the Drawing(s), scale and align at the Drawings tab 
3. Click on the Takeoff tab define the project boundary and input elevations and areas. 

Depending on the file type, there are five different takeoff methods: i) digitize the item 
with the mouse ii) use auto or easy trace iii) select the entire entity from vector files iv) 
snap to an entity point within the object using vector files and v) import all of the items 
from a selected layer from an AutoCAD DWG file.  

4. Click on the Calculations tab and set the grid size, resolution and then calculate.  
5. Review the calculated results at the 3D View, Cross Sections, Grid Data and Soil 

Analysis tabs.  
6. If changes need to be made, select the object or use the Checking | Examine menu to 

edit the information on the right side of the Takeoff tab 
7. Once the data appears reasonable, recalculate the project with High or Very High 

resolution.  
8. Finally, print the desired reports found under the Reports menu on the toolbar.  

 
 

O. 	Boring	Logs	

 
Boring logs must be setup and taken off when cut volumes by soil type are required. 
SiteWorx/OS uses the data from boring logs to model the soil layers (strata) found on the site. 
The data entry process involves digitizing the boring location and entering the data for the soil 
types found in the boring log.  
 
Entering Borings for the Tutorial Project 

 
To enter boring log data to the tutorial project recently completed, perform the following: 

 
1. Save the tutorial project as a different name. Tutorial with borings.ves for example.  
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2. At the Takeoff tab, Select Topsoil Strip and delete the topsoil strip area since the 
topsoil is defined by the boring logs.   The delete object button is found on the right 
side of the window to the immediate right of the green checkmark. 

3. At the Drawings tab, right click the mouse overtop the drawing and select Duplicate 
Drawing.  Change the page number on the toolbar to 3. Finally click the Align Dwg. 
button to align page 3, the Boring log drawing, to pages 1 and 2.   

4. Print or view on a second monitor the boring logs found as an Appendix at the end of 
this tutorial.  

5. At the Project tab, click on Yes at the Borings section of the toolbar and click on 
Setup.  

6. Setup the boring log data entry and soil types as noted on the Sample Project Boring 
Logs found at the end of this tutorial.  

7. After setting up the borings at the Project tab, digitize the borings and soil types by 
selecting Boring Log at the Takeoff tab.  

8. When done entering the borings and soil depths, calculate the project and look at the 
Soil Analysis tab and Reports | Cut by Soil Type to review the results.  
 
 

Entering Boring logs is a three step process: 
 

1. Look at the logs and set up the data entry at the Project tab. Boring logs present the soil 
strata depths several ways. Sometimes the log shows no surface elevation. Sometimes the 
elevation at the bottom of the strata and/or depth of the strata below the surface may be 
provided for each stratum. The choice of which number to enter depends on the actual 
boring log and is defined at the Setup tab shown below.  
 
At the Project tab toolbar, click Yes for boring logs and then click on Setup… to define 
the boring log information setup.  

 

 
 

Again, before setting up the bore log data entry, look at the boring logs and see how the 
strata depths are shown on the logs. Defining how the strata data will be entered from the 
bore logs is important. How are the elevations displayed?  Is the surface elevation set to 
0?   

 

2. Go through the boring logs and enter the different soil types. Click the Soil Types tab to 
enter the soil types.  
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At the Soil Types tab, name the soil type and define its colors, fill patterns and swell 
factors. If a soil type must be exported and removed, do not check the Use for Fill 
checkbox. Only one layer, (i.e. the top layer) can be defined as the topsoil layer. The 
colored buttons at the bottom of the window are for additions, deletions and recording 
this tabular information.  

 

3. Go through the boring logs and enter the strata by clicking the Takeoff tab, Boring Log 
selection, and record the location of the bore holes along with the strata depths.  

 

 
Like the Soil Type setup, the colored buttons at the bottom of the window are for 
additions, deletions and recording this tabular information.  

 
Boring Log Results 

  
When using boring logs, SiteWorx/OS calculates the cut volumes for each soil type. These results 
can be viewed at Reports menu | Cut by Soil Type. Additionally, a graphic presentation of the 
soil strata is shown on the Soil Analysis tab.  

  
Notes about Boring Logs 

  
Using Boring Logs changes some aspects of SiteWorx/OS: 
  

 Topsoil Strip Areas are not used. Check the Strip Topsoil box in Boring Log Setup to 
strip the site of the topsoil layer.  

 Topsoil Swell Factor at the Calculations tab is not used.  
 Site balancing is not available.  
 Subsoil Report is not available.  
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P. Importing	objects	and	elevations	from	DWG	files	

 
SiteWorx/OS imports objects from AutoCAD DWG files. If you have a DWG file, much of the 
information can be imported directly from the file rather than using the mouse to digitize the 
objects. To import objects from a DWG file: 
 

a) Click on the File menu/icon | New Project. Click on Drawings tab, save and name the project 
file DWG Import and then Open… Top of Curb.dwg file and select foot as the CAD 
drawing after clicking the Scale button.  This Top of Curb.dwg file is located at 
C:\Users\Public\Public Documents\Vertigraph\SiteWorxOS\Drawing Files. 
 

b) At the Takeoff tab, the Included Project Boundary must be digitized using the mouse before 
importing CAD objects. Before digitizing the Project Boundary, insure that Select Entity and 
Snap to Entity Point on the CAD section of Takeoff tab toolbar are turned off. After 
digitizing the perimeter of the project boundary, click the Stop Takeoff command.  
 

c) Since contour lines will be imported from the DWG file, select Contour Line and then 
Existing as the Takeoff type from the toolbar.  Next, the exiting contour lines will be isolated. 
When working with CAD layers, show the layers on the left side of the Takeoff tab window 
by turning on the Display the Layer List command from the CAD section of the toolbar. The 
width of the layer list on the left side of the window is resized using the mouse. As noted 
previously, to isolate a layer, click the Select Layers button from the CAD section of the 
Takeoff toolbar, move the mouse pointer overtop an existing contour line, right click the 
mouse and click Hide Other Layers from the popup menu. Only the existing contour lines 
should display after hiding the other layers.  After selecting the desired layer, turn OFF the 
select layers command on the CAD section of the toolbar. 

 
d) SiteWorx/OS imports contour lines and points with elevations directly from DWG files. Before 

importing, insure that the CAD menu | Use Z axis for Elevation is turned on (i.e. checked) so 
that the elevations associated with the entity will also be imported.  Importing entities is a 
process where the appropriate object is selected at the Takeoff tab, the drawing layer pertaining 
to the object is displayed, and the data for the selected object is imported by clicking the 
Import from drawing into takeoff command on the CAD section of the Takeoff toolbar. 
Please note: 

  
To import Existing Contour Lines: 

 On the Takeoff tab, select Contour Line and Existing.  
 Insure that CAD | Use Z Axis for Elevation are turned on.  
 Click the Display the Layers list command from the CAD section of the toolbar and 

display the existing contours by clicking on the EXISTING layer on the left side, layer 
listing. Or, isolate the contour line layer by clicking the Select layers command from 
the CAD section of the toolbar, move the square mouse pointer over a green existing 
contour line, right click the mouse and click on Hide Other Layers from the popup 
menu.  

 Once the proper layer is displayed, turn off the Select layers command on the CAD 
section of the toolbar and then click the Import from drawing into takeoff button 
from the CAD section of the toolbar. If the Contour Lines Properties dialog box 
appears, click OK and all of the existing contour lines will automatically import from 
the DWG file. 

 When done with the existing contours, click the small black box at the top of the layers 
list on the left side and isolate the proposed contour lines.  Change the takeoff type to 
Proposed and perform the same steps for the proposed contour lines.  

 
 

To import Point Elevations: 
 On the Takeoff tab, select Point Elevation and Proposed.  
 Insure the CAD menu | Use Z Axis for Elevation is turned on.  
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 Insure the Display the layers list is on from the CAD section of the toolbar, and turn 
off all of the layers on the left side except for the layer named DESIGN POINTS. The 
proposed point elevation layer can also be isolated by clicking the Select layers 
command from the CAD section of the toolbar, moving the square selection pointer 
over a proposed point and right clicking the mouse to select the Hide Other Layers 
command.  

 Once the proper point layer is displayed, insure the Select layers command is turned 
off and click the Import from drawing into takeoff button from the CAD section of 
the toolbar to import the proposed points.  

 
  

To record Area Elevations: 
 Sometimes areas are not properly closed to the first point by the creator of the DWG 

file. As a result, area elevations are often digitized from the DWG file using the Snap 
to Entity Point command from the CAD section of the toolbar rather than importing 
the areas. Click the Snap to Entity Point command on the CAD section of toolbar to 
turn on this feature.  

 To digitize areas insure that Options | Use Z Axis for Elevation is not on and Options 
| Show Properties/Elevation Dialog is clicked on.  

 Use the CAD | Layers menu to display the desired areas or isolate the layer from the 
drawing using the Select Layers command from the CAD section of the toolbar. Please 
display the SLAB_ANNOT, SLAB_ON_GRADE, PK_LOT and PK_LOT_ANT 
layers. 

 Once the proper layers are displayed, click the Start Takeoff action and click a corner 
of the slab and the Area Elevation Properties dialog should display. In the dialog box, 
record a Proposed Elevation of 107. 33, insure that the Area Type is Surface, enter a 
4 for Overcut, .33 for Above Grade, change the Color, select a Fill Style by clicking 
the three dot lookup button, name that area “SLAB” and finally, click the OK button. 
Click on the next three corners and when completed, right click the mouse and select 
Stop Takeoff. On the right side of the window, click the Layers tab and input the 
material layers of concrete with a depth of .5 and Select fill with a depth of 2 which is 
applied to the overcut area by checking the Include Overcut checkbox. When 
completed, click the checkmark at the bottom of the window to record the changes to 
the material layer list.  

  
After importing the contour lines and points, and after digitizing the areas, insure that all elevations are 
properly recorded and within range by looking at the 3D View tab. Sometimes, and depending on the 
how the file was created, some elevations will be recorded with a zero value. At the Takeoff tab, select 
the object (e.g. Contour Line) and then click Checking | Examine followed by Checking | Below 
Minimum to insure that all elevations are properly recorded. The Max and Min Elevations are defined 
under the Checking menu. After clicking the Checking | Below Minimum command, the initial item 
found that is below the minimum elevation will display on the right side of the window. Click on the 
Delete selected object button on the right side of the window to delete this incorrect elevation item and 
move to the next item.  
 

Congratulations, you’re now ready for a real project.  
 
Any questions, comments or suggestions, please contact us at any time. We wish you the best of 
everything.  
  
Vertigraph, Inc.  
12959 Jupiter Road, Suite 252 
Dallas, TX 75238 
214-340-9436 
800-989-4243 
support@vertigraph.com 
www.vertigraph.com 
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Q. Appendix	‐	Sample	Boring	Logs	

 

Boring Results for SiteWorx/OS Sample Project 

Listing of Soil Types (assume all soil types have a swell factor of 1.30): 

Soil Type Topsoil Use for Fill 
Grass and Topsoil Yes No 

Highly Weathered Sandstone  No 

Lean Clay 1  Yes 

Lean Clay II  Yes 

Limestone  No 

Sandstone 1  No 

Sandy Lean Clay I  Yes 

Sandy Lean Clay II  Yes 

Sandy Shale  No 

Sandy Silty Clay  No 

Shale  No 

Silty Sand  Yes 

Weathered Sandstone  No 

Weathered Sandy Shale  No 

Weathered Shale  No 

 

List of Borings: 

Boring ID: B-1  Surface elevation: 104.10 

Soil Type Description Elevation at top of strata Depth in feet below surface 
Grass and Topsoil 104.10 .50 

Silty Sand 103.60 1.20 

Weathered Sandstone 102.90 3.00 

Weathered Shale 101.10 4.80 

Shale 99.30 8.00 

 

 

Boring ID: B-2  Surface elevation: 104.20 

Soil Type Description Elevation at top of strata Depth in feet below surface 
Grass and Topsoil 104.20 .50 

Sandy Silty Clay 103.70 1.20 

Weathered Sandstone 103.00 3.00 

Sandstone I 101.20 5.00 

Limestone 99.20 8.00 
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Boring ID: B-3  Surface elevation: 104.50 

Soil Type Description Elevation at top of strata Depth in feet below surface 
Grass and Topsoil 104.50 .50 

Sandy Lean Clay II 104.00 1.30 

Weathered Sandstone 103.20 2.50 

Sandstone I 102.00 3.50 

Limestone 101.00 8.00 

 

Boring ID: B-4  Surface elevation: 105.00 

Soil Type Description Elevation at top of strata Depth in feet below surface 
Grass and Topsoil 105.00 .50 

Sandy Silty Clay 104.50 1.30 

Weathered Sandstone 103.70 2.80 

Sandstone I 102.20 5.00 

Weathered Sandy Shale 100.00 8.50 

Limestone 96.50 12.00 

 

Boring ID: B-5  Surface elevation: 107.40 

Soil Type Description Elevation at top of strata  Depth in feet below surface 
Grass and Topsoil 107.40 .50 

Sandy Lean Clay II 106.90 1.30 

Weathered Sandy Shale 106.10 3.00 

Sandstone I 104.40 8.50 

 

 

Boring ID: B-6  Surface elevation: 101.00 

Soil Type Description Elevation at top of strata Depth in feet below surface 
Grass and Topsoil 101.00 .50 

Sandy Lean Clay II 100.50 1.00 

Sandy Shale 100.00 5.00 

Sandstone I 96.00 8.00 

 

 

 

Boring ID: B-7  Surface elevation: 100.60 

Soil Type Description Elevation at top of strata Depth in feet below surface 
Grass and Topsoil 100.60 .75 

Sandy Lean Clay II 99.85 1.50 

Weathered Sandstone 99.10 3.00 

Weathered Sandy Shale 97.60 4.00 

Sandstone I 96.60 10.00 
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Boring ID: B-8  Surface elevation: 99.20 

Soil Type Description Elevation at top of strata  Depth in feet below surface 
Grass and Topsoil 99.20 .75 

Sandy Lean Clay II 98.45 1.20 

Sandy Lean Clay I 98.00 1.70 

Lean Clay I 97.50 3.00 

Lean Clay II 96.20 4.00 

Weathered Shale 95.20 8.00 

Sandstone I 91.20 10.50 

 

Boring ID: B-9  Surface elevation: 104.20 

Soil Type Description Elevation at top of strata Depth in feet below surface 
Grass and Topsoil 104.20 .50 

Sandy Silty Clay 103.70 1.10 

Highly Weathered Sandstone 103.10 2.70 

Weathered Sandstone 101.50 4.70 

Sandstone I 99.50 6.50 

Sandy Shale 97.70 7.50 

Limestone 96.70 9.80 

Sandy Shale 94.40 12.00 

 




